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AIROBS™
Application and Demonstration Data Set

Installation Guide for use of AIROBS with the
Demonstration Data Set

What hardware must I have in order to use AIROBS?
You must have a standard PC running Microsoft Windows with a minimum RAM of
512MB and available disk space of 1GB.

What software needs to be on my computer before I try to use AIROBS?
You must have Microsoft Windows NT (Service Pack 6), Windows 2000, or Windows
XP operating system.  You must have ESRI ArcGIS 8.2 or 8.3 (either ArcView or
ArcInfo).  ESRI 3-D Analyst is necessary to use the 3-D analysis functions of
AIROBS, although the other functions of AIROBS will operate without 3-D Analyst
installed.  You must have Microsoft Access 2000 and Excel 2000.

What do I need to do to my computer before installing AIROBS?
Create folders to store your AIROBS installation files and the demonstration
database.  The following folder structure is recommended.

C:\AIROBS\
C:\AIROBS\Install\
C:\AIROBS\ Demo_Data\

If you prefer, you can create the \AIROBS folder and its subfolders on a drive other
than the C:\ drive, or on a networked server, which can be accessed by your
computer through mapped drives or UNC connections.  However, using the
recommended folder structure above will save you several steps during the AIROBS
setup process.  To save you time, it is strongly recommended that you use the folder
structure shown above for trying out AIROBS.

How do I obtain the AIROBS installation and data files?  Where do I place them
on my computer?

Download the required AIROBS files from the CADD/GIS Technology Center
website:  https://tsc.wes.army.mil.  Place the installation zip file
(AIROBS_Rev1.2_Install.zip) in the folder …\AIROBS\Install\ and place the
demonstration data set file (AIROBS_demo_data.zip) in the folder …\AIROBS\
Demo_Data\.

Once I’ve downloaded the files, how do I install AIROBS and the
demonstration data set?
1. Close all active applications that are running on the computer.
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2. If you have already installed AIROBS and need to re-install it, first uninstall
AIROBS according to the instructions provided under the next question.

3. In Windows Explorer,  navigate to the folder …\AIROBS\Install.
4. Double-click on the file setup.exe and follow the instructions.  This will install the

application to C:\Program Files\AIROBS and also files related to the application,
such as the user manual, references, templates, and pictures.

5. In Windows Explorer,  navigate to the folder …\AIROBS\Data\.
6. Unzip the file AIROBS_demo_data.zip by double-clicking it.  When Winzip opens,

click the Extract button. Extract the files to the folder ..\AIROBS\Demo_Data\.
5. If you obtained the demonstration data set from CD, you must remove the read-

only property from the files. To do this, in Windows Explorer right-click on the
Demo_data folder, select Properties, un-check the “Read-only” box listed under
the Attributes section, click the Apply button, check “Apply changes to this folder,
subfolders and files”, and click OK.

How do I remove the application?
Removal of the application in Windows 2000 is done through the Add/Remove
Programs function. To activate this function, navigate to Start > Settings > Control
Panel
> Add/Remove Programs, select the AIROBS program, and click the
Change/Remove button.

How do I start AIROBS?
Once the application is installed, you can run AIROBS the same way you run many
other applications.   Click the Windows Start button and navigate to Programs >
AIROBS. If for any reason the application does not appear at this location, it can
also be launched by navigation to the folder C:\Program Files\AIROBS and double-
clicking on AIROBS.exe.

How do I set up AIROBS to access the demonstration data?

Standard Method (C:\AIROBS folder used)

When AIROBS is started for the first time on your computer, it needs to know the
name and location of the demonstration data set.  If you placed the demonstration
data in the C:\AIROBS\Demo_data\ folder, as recommended, this is done in two
steps, as follows.
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When AIROBS is started, you will see the AIROBS home screen.

Click the Setup tab to show the Setup screen, then click Set Database.   At the next
screen, in the Database entry box, browse to the location of the obstructions
database, C:\AIROBS\Demo_Data\Database\Demo_obs.mdb.  Leave the Password
entry blank.  Click the Next button.

Click the Home tab and set the Airbase to Demo_AFB and the Criterion to
Demo_Airspace.

You have completed the installation and are now ready to use AIROBS as described
in the User Manual.

Non-Standard Method (folder structure other than C:\AIROBS\ was used)

If you chose to place the demonstration data in a folder other than
C:\AIROBS\Demo_data\ folder, complete the above step, plus the following steps.
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Click the Setup tab and choose Set Airbase Map and Info. You need to direct
AIROBS where to find the various map layers that it uses.

For each entry, browse to the location shown below, then Click OK.
Airbase Basmap File:
: …\AIROBS\Demo_Data\mxd\Demo.mxd
Airbase Ground Surface TIN File:

…\AIROBS\Demo_Data\Mapping\Ground_TIN
Priority Risk Area Shape File:

…\AIROBS\Demo_Data\Surfaces\priority_airfield_buffer_zone_area.shp
Runway Centerline Shapefile:

…\AIROBS\Demo_Data\Surfaces\airfield_surface_centerline.shp

Under the Setup tab, choose Set Airfield Criteria. You need to direct AIROBS where
to find the various map layers related to the regulatory airspace surface.

From the list of Available Criteria, select Demo_Airspace (move it into the Selected
Criteria box using the right arrow), and click Edit.
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For each entry under Criterion Detail, browse to the location shown below.  When
complete, click Apply.
Airspace Surface TIN File:

…\AIROBS\Demo_Data\Surfaces\Airspace_TIN
Airspace Surface Shape File:

…\AIROBS\Demo_Data\ Surfaces\ airfield_imag_surface_area.shp
Taxiway/Apron Clearance Shape File

 …\AIROBS\Demo_Data\Surfaces\
Apron_Taxi_airfield_buffer_zone_area.shp

Modifying the setup of airspace criteria will result in related obstruction violations
being deleted from the database.  This is done to maintain data integrity. The
following warning box will appear upon applying the modifications:

Click the Yes button.  You will need to reanalyze the obstructions later to add the
violations information back into the database.

MXD Modification AIROBS uses the ArcGIS project file demo.mxd to control what
map layers are displayed and how they are symbolized in AIROBS.  Demo.mxd is
already set up for you.  However, it references map layers that are expected to
reside in the C:\AIROBS\Demo_data\mapping\ path.  Since you have chosen to
place the map data in a different location, you must reset the source paths for those
layers within the mxd.  Exit AIROBS by clicking Exit.  Open demo.mxd in ArcMap.
Reset the source path for each layer by right-clicking the layer name, choose
Properties, choose the Source tab, and browse to the location in which the layer was
placed.  After each layer’s source is reset, save the mxd file and exit ArcMap.

You can now restart AIROBS, and the map layers should be properly referenced.

Obstructions Analysis Since you reset the location paths of the files related to
the airspace surface, you must perform a reanalysis of the obstructions.  Follow the
instructions for performing this analysis in the User Manual, pages 12 and 33.
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Quick Start Guide

For Implementation of AIROBS at USAFE Bases

What do I need to do to my computer before installing AIROBS?
The AIROBS application and the obstruction data and related files are provided on CD-
ROM.  To prepare for the installation, the following modifications are required on the
computer:

1. Create a folder on the hard drive called C:\AIROBS.

2. Under the C:\AIROBS folder, create another folder for the base data.  This folder should
be the name of the installation without spaces in the name, e.g.
C:\AIROBS\Ramstein_AB, C:\AIROBS\Spangdahlem_AB, or C:\AIROBS\Aviano_AB.
This folder will store all the data for the operation of AIROBS.

3. Before installing the application, any previous installations of the application should be
removed.  This is done by navigating to Windows Start > Setting > Control Panel >
Add/Remove Programs > AIROBS.

4. If the user has stored any other files in the program location (C:\Program
Files\AIROBS), using file management software, these files and all related folders
should be removed.

How do I install the application?
The application is provided on a CD-ROM.  If the application has previously been installed,
it is recommended that you uninstall the application before installing the application.

1. Close all active applications that are running on the computer.

2. Insert the CD-ROM in the drive and navigate to the drive.

3. Click on the file setup.exe and follow the instructions.  This will install the application to
C:\Program Files\AIROBS and also files related to the application such as the user
manual, references, templates, and pictures.

How do I remove the application?
Removal of the application in Windows 2000 is done through the Add/Remove Programs
function.  To activate this navigate to Start > Settings > Control Panel > Add/Remove
Programs and select the AIROBS program and click the Change/Remove button.

How do I load the AIROBS data?
When the application is provided, three CD’s are included for the complete installation.
One of these CD’s is the AIROBS Data CD.  This contains the airfield obstruction database,
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airspace TIN and shape files, taxiway/apron clearance buffer shape files, priority area shape
file, and the runway/taxiway centerline shape file.  The files are stored on the CD in the
appropriate folders for use with AIROBS on the hard drive.  To use these files, they need to
be copied to the hard drive to folder a called C:\AIROBS\[Installation Name] that is created
by the user.  After the folders have been copied from the CD to the hard drive, the folders
on the hard drive will retain the read-only properties from the CD location.  In order to use
the database and associated files, the read-only properties need to be removed.  This is done
in Windows Explorer by right clicking on each of the folders, clicking on “Properties”, and
un-checking the “Read-only” box listed under the Attributes section.

How do I load the map files?
When the application is provided, three CD’s are included for the complete installation.
One of these CD’s is the Mapping (or Common Installation Picture) data CD.  This contains
the current map layers for the installation and the required MXD file for use with AIROBS.
The files are stored on the CD in the appropriate folders for use with AIROBS on the hard
drive.  To use these files, they need to be copied to the hard drive to folder a called
C:\AIROBS\[Installation Name] that is created by the user.  After the folders have been
copied from the CD to the hard drive, the folders on the hard drive will retain the read-only
properties from the CD location.  In order to use the database and associated files, the read-
only properties need to be removed.  This is done in Windows Explorer by right clicking on
each of the folders, clicking on “Properties”, and un-checking the “Read-only” box listed
under the Attributes section.

How do I start the application?
Once the application is loaded, the application will appear under the listed programs on the
computer.  To start the application navigate to the Windows Start button > Programs >
AIROBS.  If for any reason the application does not appear in this location, the program can
also be launched by navigation to the folder C:\Program Files\AIROBS and clicking on
AIROBS.exe.

How do I setup a new airfield?
On the initial use of the application, the user needs to specify the airfield location.  Data has
been provided for the specified airfield that provides the existing airfield obstructions, base
mapping, airfield obstruction surface criteria files, and related files.  Listed below are the
steps to setup the airfield obstruction database and base mapping files for use with any
criteria.
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Database Installation
1. Open Home Screen

2. Select Setup

3. Select Set Database and navigate to the
database provided for the installation by
hitting the Browse button.  The default
location for the database is
C:\AIROBS\[Installation
Name]\Database.  If the database is
secured with a password, enter the
password in the provided field.  The
database does not have a password at
initial installation.  When done, hit the
Next button.

4. From the drop down list, select the
installation and click the Finish button to
complete the database installation.
When this button is clicked, there will be
some delay as the database is configured
for operation with AIROBS.  If the
database has not been previously
analyzed this message will appear,
“There are no obstructions in the
database for the selected criterion. No
layer was created.”    This is expected
and will be corrected as soon as the data
is analyzed against airspace criteria.
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Airbase Map and Info Installation
1. Open Home Screen

2. Select Setup

3. Select Set Airbase Map and Info.  The
following fields will then need to be
populated by the user:

• Airbase Name: Enter the name of the
installation.

• Airbase Basemap File: Browse to select
the MXD file to be used to display
obstruction data in AIROBS.  The MXD
provided at installation is located at
C:\AIROBS\[Installation Name]\MXD.
Note that other MXD files may be used,
however the E-tab creation function will
not operate correctly if the incorrect MXT
file is included.

• Airbase Ground Surface TIN File: When
available this file is located at
C:\AIROBS\[Installation
name]\Mapping.

• Priority Risk Shape File: The default
location for this file is
C:\AIROBS\[Installation
Name]\Surfaces.

• Runway Centerline Shape File: The
default location for this file is
C:\AIROBS\[Installation
Name]\Surfaces.  This file also includes
required information for the calculation
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of distances to taxiway centerlines.

When all available files have been selected,
click OK to load the files.  This process may
take a few minutes depending on the size of
the MXD and ground surface TIN files.

How do I setup the airfield obstruction surface criteria?
The airfield obstruction surface criteria for the installation is provided on the AIROBS Data
CD.  To setup this data for operation in AIROBS, the following steps are required.

1. Open Home Screen

2. Select Setup.

3. Select Set Airfield Criteria. A list of
typical airfield criteria is shown on the
left.   Select from the Available Criteria
list, those criteria that have been
provided for the installation by using the

 button.  When the criteria are selected,
for each criterion in the Selected Criteria
box, click the Edit box and populate all
fields in the Criterion Detail area:

• Airspace Surface TIN File: Click the
browse button and navigate to the
location of this file.  The file is located at
C:\AIROBS\[Installation
Name]\Surface\[Criterion] when
initially installed.

• Airspace Surface Shape File: This file is
located in this same location as the
Airspace Surface TIN File when initially
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installed.

• Taxiway/Apron Clearance Shape File:
Located at C:\AIROBS\[Installation
Name]\Surface\[Criterion] when
initially installed.

4. Once all entries are complete for a
selected criterion, click the Apply button.
At this point the message shown to the
right will appear.  This is a warning to
the user that changes to the criterion files
will remove obstruction analysis results
currently stored in the database.  If the
user wants to reanalyze obstruction
using the selected criterion, click on the
Yes button.  At initial installation of the
application, this message will appear for
each criterion.

5. When all required criteria are setup, click
the close button to return to the main
application to perform obstruction
management functions.  If the criterion
files have been modified or this is a new
criterion, this message will appear.

How do I enter a new obstruction?
In a typical installation, known obstructions are provided with the initial installation of the
application.  However, the application is intended for management of obstructions allowing
the user to add, modify, or delete obstructions as conditions change on the airfield.  To add
a new obstruction, the following steps are required.

1. The process begins with the analysis
of the obstruction.  This will
determine if the object is indeed an
obstruction because it violates a
given a given criterion.  On the Home
Screen click on Tools > Analyze
Obstructions or on the ArcMap view,
click on the N button to activate this
screen.
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2. Now click on the New Siting
Analysis to place the object and
either enter the coordinates of the
object in X Coord and Y Coord fields
or click on the map at the location.  If
a ground TIN file has been loaded
and the location of the object is
within the boundaries of the TIN file,
the Ground Elevation will be
populated when clicking on the map.
The height of the object must be
entered to perform the analysis.  The
height is measured from existing
ground elevation and must be in the
same unit of measurement as the
ground mapping.

3. Select the criteria to be analyzed.
This is done by selecting from the
Applicable Criteria on the left and
using the  button.
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4. Select the type of analyses to be
completed by checking the boxes and
clicking the analyze button to
perform the analysis.

5. The analysis results are displayed in
the results box.

Note:  That it is possible to get a negative
maximum allowable height value.  See
discussion on this at the end of this
section.
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6. To save this obstruction to the
database, click on the Save Data to
DB button and the Add New
Structure box will appear.  To add
the obstruction to the database, the
following fields must be populated
by the user at this stage:

• Obstruction Number: This is the
unique identification number for this
obstruction.  For USAFE, a
numbering system has been
determined and is provided in the
Reference materials.  The user is not
permitted to enter an obstruction
number that has already been used.
To obtain the last number in a
sequence, export the obstruction data
and sort by obstruction number.

• Obstruction Classification: Select this
from the drop down list.  For
guidance on Permissible Deviations,
click the Help button.

• Waiver Status and Date: These fields
must be populated if the obstruction
classification is Temporary or
Permanent Waiver.  The date is
entered as month/date/year
(mm/mm/yyyy).

• Construction Type: Select either
Temporary (e.g. tents, construction
cranes, etc.) or Permanent.

• Frangible:  In the Survey Information
area, select the frangibility of the
object.  The Obstruction Frangible
under Basic Info is populated from
this area.

Other fields may be populated if the
information is available, however the
bullet listing above is the minimum that
must be entered.  For assistance with all
other fields, see the Edit Obstruction
information in the Software
Documentation.

When the required fields are populated,
click OK to save the obstruction.  Note
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that the obstruction will not be
immediately displayed.  To refresh the
obstructions displayed on this screen,
use the View/Refresh Obstructions
button:

Negative Allowable Height
AIROBS works by determining if the top elevation of a given obstruction is above or below
the airspace/imaginary surface as defined by a TIN file.  The TIN file represents the
imaginary surface for the airspace and is composed of 7 or 8 facets.  The coordinates of the
ends of the runway (thresholds) set the bottom elevation of this TIN file.  The bottom facet
of this surface is the Primary Surface and is 1,500 ft to 3,000 ft wide.  In section the primary
surface extends horizontally from the centerline for the entire width.  If the ground
elevation within the primary surface is higher than the primary surface, AIROBS will return
an available height that is negative.  This is actually a true result and one that airfield
managers should investigate as it may indicate areas that are not correctly graded.

How do I modify the information about an obstruction?
To modify the information about an obstruction the user must access the Edit Obstruction
screen.  This is done from the Home Screen > Tools > Edit Obstructions and scrolling to and
selecting the obstruction to be modified.  Alternatively, clicking on the obstruction in the
ArcMap environment with the Identify Obstruction tool will bring up the same form.  For
information on data entry fields on this form see the Software Document section on Edit
Obstructions.

How do I group survey points into an obstruction?
Certain objects that violate airfield obstruction criteria should be grouped into a single
obstruction.  Examples of these obstructions are tree areas, aircraft arresting systems, fences,
and similar objects that are of the same function or nature and are located in close proximity
to each other.  To group obstructions in AIROBS, these are the steps:

1. Create a new obstruction for one of the objects in the group.  This is done the same way
as all obstructions (see “How do I enter a new obstruction?” section).  Once the
obstruction is saved, return to the obstruction and open the Edit Obstruction form.

2. To add another survey point to the obstruction, click the Add button in the Survey
Information section.  In order to the add the point, the X Coord, Y Coord, Frangible, and
any two of the Height, Ground Elevation, and Top Elevation fields are required to be
populated.  Coordinates are entered directly into the fields and can not be selected from
the ArcMap view.

3. After entering the data for each survey point, click the Apply button to save the data to
the database.

4. When all the survey points have been entered click the OK button to save the
obstruction information.
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5. To display all the survey points on the map, an analysis of the entire database is
required in order to determine the violations of each survey point.

How do I label an obstruction?
To label the obstructions as displayed in the ArcMap, follow these steps:

1. Click on Data Layers > Table of Contents or the View Table of Contents button: 

2. Right click on the Obstructions layer and check the Label Feature.

3. Close the Table of Contents window.

Obstructions will be labeled with the obstruction number by default.  To change the label,
select Properties of the Obstructin layer and select the Labels tab.

How do I delete an obstruction?
To delete an obstruction from AIROBS, click the Edit Obstructions form to open this box.
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Scroll to the obstruction to be deleted and click Delete.

Note:  This action does not permanently delete the record from the database, it simply
removes it from further consideration by AIROBS.  The database retains the record, but flags
it as having been deleted.  If the record needs to be retrieved, contact the Program Contacts
for assistance with the modifications required in Microsoft Access.

How do I perform a new siting analysis?
The steps for the siting analysis are the same as described in the  “How do I enter a new
obstruction?” section.  This is done from Home Screen > Tools > Analyze Obstructions or by
clicking the “N” button on the to access the Analyze Obstructions modules.  The results of a
siting analysis do not need to be saved each time allowing for siting alternative
investigation.

How can I create a Form 582?
Users can produce Form 582 reports for all unapproved obstructions only.  Obstructions
that have been approved previously or do not require a Form 582 approval, e.g. Permissible
Deviations, are not available for producing a Form 582.  These are the steps to be taken to
produce this form:

1. From the Home Screen select Tools >
Forms and Reports
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2. Select 582 (New Waiver Request) and
click Next.  To modify the location where
the Form 582 will be saved, click the …
button and browse to the desired
location.  The default setting for is the
Windows My Documents folder.

3. Select the structures for which the Form
582 is required from the Available
Structures box on the left using the 
button and click Finish.

The form is created and stored at the specified location with a file name of [Obstruction
Number]_582.xls.  The form will need to be adjusted in accordance with the user’s printer
configuration or for export to other formats.

How can I create a Form 583?
The Form 583 is required for Permanent and Temporary Waivers only.  The creation
procedures are the same as the Form 582 apart.  The difference is that obstructions can not
be individually selected as the report is intended for reporting all obstructions that are
Temporary Waivers.  The report is saved as specified by the user and is named 583.xls.
While the report is being created the status of is displayed in the lower left corner of the
screen.  The final Excel file includes three worksheets: Permanent Waivers, Temporary
Waivers, and Permissible Deviations.  The latter form is intended for base use during
ATSEP reviews and is not to be submitted to the MAJCOM.

How can I print an E-Tab map?
The workflow on the next page provides the means by which the E-tab map template is
accessed.  The user is referred to ArcGIS reference and help functions for assistance with
formatting the final E-tab layout to meet base requirements.
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Tools

Start ArcView

Go to Layout View

Set Legend Items
and Format

Modify Scale Bar

Set E-tab Number

Modify Scale and
Date
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Introduction

USAFE Program Contacts
USAFE
Robert Rushing
HQ USAFE CEPP
GEB 529
66877 Flugplatz Ramstein
Germany
Telephone (COM):  +49-6371-47-6923
E-mail:  robert.rushing@ramstein.af.mil

Juergen Hammel-Mueller
HQ USAFE CEPP
GEB 529
66877 Flugplatz Ramstein
Germany
Telephone (COM): +49-6371-47-6923
E-mail:  Juergen.Mueller2@ramstein.af.mil

CH2M HILL
Tom Ryburn
Kantstraße 9
67663 Kaiserslautern
Germany
Telephone (COM):  +49-631-892-9810
Fax:  +49-631-892-9815
E-mail: tryburn@ch2m.com

Daniel Moreno
9193 S. Jamaica St.
Englewood, CO USA  80112
Telephone 720 286-5304
Fax:  720 286-9821
E-mail: dmoreno@ch2m.com

Program Overview
Program History
The Airfield Obstructions Tracking, Analysis, and Management System (AIROBS) software
application was created by CH2M HILL for the United States Air Forces in Europe (USAFE).
This application is a response to the US Air Force’s Airfield Obstruction Reduction Initiative
(AORI) to assist USAFE with the analysis and management of obstruction waivers.  For the
waiver process, USAFE must create and submit an annual report that tabulates the status of
obstructions that exist at each of its bases. USAFE required tools that determined and
managed obstructions to air navigation and on the airfield at the Main Operating Bases in
Europe. AIROBS was developed to perform three-dimensional analyses to determine
surface violations, display data visually, create waivers for new obstructions, and produce
summary reports and maps of identified obstructions. AIROBS interacts with existing base
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map data, three-dimensional surfaces (based on user-specified airspace criteria, commonly
UFC criteria), and survey data to determine objects that are obstructions to navigation and
to report these findings. The application is owned by the United States Air Force.

AIROBS uses various data/inputs to run analyses and create reports. A flow chart detailing
the elements AIROBS uses is shown as Figure 1.

Base
ArcMap *.mxd

Obstructions
Microsoft Access

*.mdb

Criteria
ArcGIS TIN and

Shape Files

Vector
Common Installation
Picture (CIP) *.mdb

Raster
Aerial Photography (*.sid)

Scanned Regional Mapping
(*.tif or *.jpg)

AutoCAD

Bentley SelectCAD

Waiver Data from Base
*.xls and Hard Copy

Survey Data
*.csv and *.xls

Imagery
*.jpg

Adobe Acrobat
- Criteria Manuals

AIROBS

Storage
SDS Data Tables

AF Forms
Microsoft Excel

E-Tabs
ArcMap to Adobe

User Input
Siting Analysis

Airspace TIN
Airspace Shape
Taxiway/Apron Shape
Runway/Taxiway Centerline
Priority Area Shape

TIN
Ground Digital Terrain

Model

Figure 1 – AIROBS Data Sources and Workflow
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Installation
System Requirements
Hardware
The application is designed to operate on a standard PC running Microsoft Windows
NT/2000/XP without the need for a LAN connection. The necessary ODBC drivers and
printer drivers should be installed on each target computer before installation of AIROBS

• Minimum Hard Drive Space:  Variable based on the size of the dataset, estimated to be
approximately 200 MB

• Minimum RAM = Variable, estimated to be approximately 500 MB.

• Best screen resolution = 1024 x 768 pixels.

Software
The following software is the minimum required to run AIROBS:

• ESRI ArcView 8.2

• ESRI ArcGIS 3D Analyst Extension

• Windows NT Service Pack 6 or Windows 2000 or Windows XP

• Microsoft Access 2000

• Microsoft Excel 2000

• Adobe Reader

Required Settings
It is required that for all files and folders that the full path be displayed in the title bar.  If
this has not already been done, these are the steps to change this setting (for Windows 2000
other operating systems will vary slightly for these steps):

1. Hit the Windows Start button.

2. Open the Settings section.

3. Open the Control Panel.

4. Open the Folder Options section.

5. Click the View tab.

6. Check the box next to “Display the full path in title bar”.

The settings for the Folder View tab should then appear as shown below:
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Licensing Requirements
CH2M HILL holds the copyright for the AIROBS application, however the application is
freely distributed to all Department of Defense agencies.  Private parties wishing to acquire
the software are to contact CH2M HILL program contacts as provided above.

Disclaimer
An application disclaimer has been included with the software.  This will appear on initially
opening the application:

Ownership
The application is owned by the United States Air Force.

Copyright:  CH2M HILL, Inc. 2002

Data and Analysis
The airspace obstruction data contained in this Airfield Obstruction Tracking, Analysis, and
Management System (AIROBS) database is a collection of:

• Photogrammetric and ground survey data acquired by CH2M HILL and other USAFE
Contractors,

• Imaginary airspace surfaces, runway clear zones, and taxiway/apron clearance zones
created by CH2M HILL, and

• Supplemental airfield obstruction waiver, obstruction, and mapping data provided by
HQ USAFE/CEPP and responsible air base staff.

The AIROBS database is for planning and programming purposes, not for the purposes of
establishing aircraft flight procedures. In addition, the AIROBS database does not identify
all possible obstructions to air navigation in or around the air base.

Data Accuracy
Any obstructions identified are only valid, given the accuracy for which the data was
acquired, and are only accurate for that date on which the data was acquired. The
obstructions should be considered preliminary and for planning purposes only until
verified by responsible air base staff.
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The accuracy for the CH2M HILL photogrammetrically generated obstruction data and
ground surface terrain model data is nominally plus or minus 1-meter horizontally and plus
or minus 1-meter vertically.

The disclaimer can be turned off after initial viewing by unselecting the “Show at startup”
button.

Licensing
Specific licensing requirements exist for ArcView, 3D Analyst, Microsoft Excel, and
Microsoft Access software platforms. The user is referred to the specific language included
with each of these software packages for more detailed licensing information.

User Training
Typical training requirements depend largely on user familiarity with GIS and database
management.  There are two typical installations for this application.

GIS Analyst
This installation is for the primary user at each airbase.  This is the individual designated to
analyze airfield obstruction data, prepare waiver applications, and manage the associated
mapping and data required for the application.   Typically, this is an experienced GIS
analyst familiar with ESRI software and management of the associated databases.  Training
for the GIS Analyst will typically require approximately 1 - 2 hours of classroom and
individual instruction.

Data Viewer
For most other users, the application is only used to view obstruction data as analyzed by
the GIS Analyst.  For these users, knowledge of all the AIROBS functions is not required.
However, it is assumed that these users are not proficient in GIS functionality and will
require training that includes minimal GIS functions in addition to the AIROBS functions.
Training for the data viewers will vary widely, but is estimated to require approximately 2 -
4 hours of classroom or individual instruction.

Directory Structure
Listed below are the locations of the application and associated data files for the application.
Actual installation drives may vary, for instance the data files may be located on the D:
drive instead of the C: drive as indicated.  However, the directory structure must be
maintained regardless of the actual drive location.  Installation of the application and related
data on a network server is discouraged in order to maintain data security and maintain
application-processing speed.  Relocation of the application files may cause the application
to malfunction.

Program Location
The application is installed at

C:\Program Files\AIROBS\AIROBS.exe

Users Manual
This document is loaded with the application and is stored at
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C:\Program Files\AIROBS\UserManual\UserManual.pdf

Reference Material
Reference material, such as UFC Criteria and other manuals that may be required to
complete the analysis, may be loaded by the user and directly opened from within the
application (Reference Material button).  As a minimum for application installation at a
military airfield, Attachment 14, "DEVIATIONS FROM CRITERIA FOR AIR FORCE
AIRFIELD SUPPORT FACILITIES" from the Unified Facilities Criteria is loaded.  These files
are provided in Portable Document Format (PDF), but this is not a requirement and files of
any format can be stored in this location.   These files must be stored in this directory to be
accessed directly from the application:

C:\Program Files\AIROBS\References

Reports
AIROBS produces output in a number of ways, from summary views of the obstructions to
detailed reports. The following reports can be generated in Microsoft Excel format using
AIROBS:

• Form 582: New Waiver Request Form

• Form 583: Annual Waiver Summary Report, and

• Priority Risk Area Report.

The templates for these forms use Microsoft Excel and are located at:

C:\Program Files\AIROBS\Templates

Data Sources
Running the AIROBS application requires several data source files.

Airfield Obstruction Data Base
This is a SDS-Compliant Access 2000 database (*.mdb file) that contains the surveyed objects
and stores the analyzed obstructions.  The file has a specific format and can not be altered
by the user.  The database is supplied with the installation of the application.  The database
may be stored at any location designated by the user.  At installation this file will be loaded
in to a directory called:

C:\AIROBS\[Installation Name]\Database

Airfield Obstruction Photographs
When available, digital images of surveyed objects can be viewed within the AIROBS
application.  The images can be of any digital format and are stored at:

C:\AIROBS\[Installation Name]\Photos

If the images are stored at a different location, the location will need to be mapped to the
image from within the AIROBS application.  This is done in the Edit Obstruction data form
using either the Add or Edit commands in the add photo dialogue box to set the location.



30

Aerial Photographs
Ortho-rectified aerial photographs, can be used as part of the *.mxd file in AIROBS.  These
files are typically MrSID imagery or TIFF files and are stored at:

C:\AIROBS\[Installation Name]\Aerials

The most recent aerial imagery for the installation will be included in the MXD file at
installation.  To update the aerial imagery for the installation, the MXD file must be
modified to include the new imagery using ArcMap.  Aerial imagery should be obtained
from the installation GeoIntegration Office (GIO) or from HQ USAFE GIO.

Airspace TIN Files
These files will be provided at installation of the application.  This file is specific to GIS and
represents a three-dimensional model of the airspace.  A TIN file is a Triangulated Irregular
Network file, a means of representing facets of a three-dimensional surface by means of
interconnected triangles formed from known lines or points in space.  Several
interconnected files in GIS represent a TIN file.  For typical USAFE installations three
airspace TIN files are provided for the USAFE, ICAO, and ICAO Inner Approach/Inner
Transitional criteria.  These files are stored in one location.  At installation the files are
loaded into the following directory:

C:\AIROBS\[Installation Name]\Surfaces

These files will not be updated unless there are major modifications to the runway(s).  Users
should contact HQ USAFE CEPP to obtain new Airspace TIN files in the event of major
modifications to the runway(s).

Ground Surface TIN Files
When available, a three-dimensional model of the ground surface will be provided.  This is
similar to the Airspace TIN file, but represents a model of ground based on previous survey
information obtained from ground or aerial survey methods.  This file is located at:

C:\AIROBS\[Installation Name]\Mapping

The ground TIN files provided at installation are from the most recent survey of the
installation.  As the installation maps are updated, the ground TIN file will be updated.
Users should contact the base-level or HQ USAFE GIO to obtain updates to the ground TIN
file.

GIS Shape Files
A Shape file is a vector data storage format for storing the location, shape, and attributes of
geographic features. A shape file is stored in a set of related files and contains one feature
class. This is the characteristic appearance or visible form of a geographic object. Geographic
objects can be represented on a map using one of three basic shapes: points, lines, or
polygons.  In this application three distinct shape files are required:

Airspace Shape File
This file is composed of polygons representing the "shadow" of the three-dimensional air
space on the ground.  The polygons are the different facets of the airspace such as the
primary surface, inner horizontal, and approach/departure surfaces that in combination
make up the entire airspace surface.  In addition, the runway Clear Zone (B-surface) is
included in this file.   An airspace shape file is provided for each airspace criteria.  For
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typical USAFE installations, there are three primary air space criteria: USAFE, ICAO, and
the ICAO Inner Approach/Inner Transitional surface.  Other surfaces are provided as
required by the base mission.  The files are located at:

C:\AIROBS\[Installation Name]\Surfaces\[Criteria]

Taxiway/Apron Clearance Zone Shape File
For a given airfield criteria, specified clearance zones are required from the taxiways and
aircraft parking aprons.  These zones are represented in GIS as polygons associated with
each base feature and combined in a shape file.    For a typical USAFE installation
taxiway/apron clearance shape files are provided for USAFE and ICAO criteria.  This file is
stored in the same directory as the specified criteria:

C:\AIROBS\[Installation Name]\Surfaces\[Criteria]

Priority Risk Area Shape File
Based on the Airfield Obstruction Reduction Initiative, the USAF has established three
priority areas for the removal of obstructions.  These are sequential buffers from the runway
and the clear zone and are represented in GIS as polygons combined in a single shape file.

Each of the shape files is stored in:

C:\AIROBS\[Installation Name]\Surfaces

Runway/Taxiway Centerline Shape File
This is a polyline shape file providing data on the runway and taxiway centerlines at each
installation.  There is a single file for each installation.  It is used to calculate the
perpendicular distance to runway centerlines and the distance to the closest runway
threshold located within 2,000 ft of the runway centerline.  In addition, it is used to calculate
the perpendicular distance to taxiway centerlines located within 200 ft of the taxiway
centerline.

This shape file is stored in:

C:\AIROBS\[Installation Name]\Surfaces

To update all files located in the Surfaces folder, users should contact HQ USAFE CEPP.
Updates to these files may be required if there are major modifications to the airfield (see
discussion on Airspace TIN files) or apron/taxiway modifications that may require this
shape file to be changed.

Base Mapping
All forms of geo-referenced digital base mapping can be used to display the obstruction
data in AIROBS.  The base mapping is used only for the display of the obstructions and is
not required for the analysis.  The mapping will typically consist of ESRI personal
geodatabase files (for USAFE this will be the Common Installation Picture (CIP) database),
and any available GIS data layers as provided by the base.   The base mapping is then
combined in ArcGIS into an ArcMap document file (*.mxd file) for use in the AIROBS
application. These files are stored at:

C:\AIROBS\[Installation Name]\Mapping

The mapping provided at installation is from the most recent CIP obtained from HQ USAFE
GIO and base-level GIO.  Users are encouraged to contact either office on a regular basis to
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obtain the most recent CIP.  Listed below are the typical CIP datasets to be referenced in the
MXD file:

• Buildings

• Cadastre

• Improvement_general

• Improvement_recreation

• Transportation_air

• Transportation_pedestrian

• Transportation_vehicle

MXD File
The *.mxd file is stored at:

C:\AIROBS\[Installation Name]\MXD

In creation of the ArcMap file for use in the application, the data sources should be
associated using complete path names and not relative path names.   While other templates
can be used in the AIROBS application, the MXD file provided at installation includes the E-
tab template (MXT) for use with the application.
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Software Documentation

Opening Screen
Home

In this dialog box, the user selects the air base to be analyzed (Select Airbase) and the
criterion to be used to analyze obstructions (Select Criterion).

Each of the titles is a hyperlink to the subsequent screens.

Activating the “Exit” hyperlink will close the application entirely.  To close this dialog box,
use the  box in the upper right corner.

Setup

Set Database
Activates the Setup dialog box that allows the user to set the file location for the database
and the default airbase. The default airbase is the airbase that will be selected in the Select
Airbase drop down menu on the Home dialog box. See Setup dialog box discussed below
for more information.



34

Set Airbase Map and Info
Opens the Edit Airbase Info dialog box. The user can edit the airbase name and select map
files; TIN files, and shape files to be associated with the airbase by using this dialog box.
Additional information on the Edit Airbase Info dialog box can be found below.

Set Airspace Criteria

Opens the Set Criteria dialog box.  The user can add new airspace criteria, e.g. UFC, FAA,
etc, and link the associated TIN and Shape files that represent the specified criteria.  See Set
Criteria dialog box discussed below for more information.

Modifications to Airspace Criteria
If criteria files have previously been setup, modifications to the setup for each criterion will
result in the related obstruction violations being deleted from the database.  This is done to
maintain data integrity.  The following warning box will appear upon applying the
modifications:

Tools

Edit Obstructions
Opens the Obstructions dialog box. From the Obstructions dialog box the user can select a
structure to edit or delete from the obstruction database. See Obstructions dialog box
discussed below for more information.

Query Obstructions
Activates the Query Obstructions dialog box allowing the user to perform data queries on
the obstructions in the database.  Options are provided to determine the obstructions that
violate user selected airspaces and clearance zones.  Alternatively, users can analyze the
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violations attributed to a single obstruction. See Query Obstructions dialog box discussed
below for more information.

Analyze Obstructions
Activates the Obstruction Analyses dialog boxes. This tool allows the user to perform
Priority Risk Areas, Airspace Surface, and Clearance Zones analyses according to selected
criteria on new or existing structures.  See Obstruction Analyses dialog box discussed below
for more information.

Forms and Reports
Opens the Reports dialog box. This dialog box allows the user to generate USAFE Form 582,
USAFE Form 583, and Priority Area Reports.  See Reports dialog box discussed below for
more information.

Export Obstruction Data
Activates the Export Obstruction Data dialog box. This function extracts the geospatial
information and obstruction identifier for all waivers and permissible deviations reported
on the USAFE Form 583.  The data is extracted to a tab-delimited file for importing into
CAD platforms used to publish the E-1 maps. See Export Obstruction Data dialog box
discussed below for more information.

Help

AIROBS User Manual
This button opens the AIROBS User’s Manual (this document) from within the application.
This is the primary source of all information related to AIROBS functions and operation.

Reference Material
This allows the user to access the reference material related to the selected airspace criteria
or other material that may be required for managing the airfield obstructions. This function
activates the Select a Reference to View dialog box.  For more information see Select a
Reference to View dialog box discussed below.
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ArcGIS Desktop Help
This provides access to the ArcGIS Desktop Help functions provided by ArcView 8.2.
Information provided in this area is related to ArcView functions and operation and does
not provide any AIROBS-specific assistance.
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ArcMap Environment

The
primary graphic user interface for the AIROBS application is ArcMap.  This environment
allows the same AIROBS functionality contained in the Open Screen and adds the ArcMap
functionality.  This section will not elaborate on the ArcMap functionality and the user
should refer to the ArcView help function provided with the application and ArcGIS
manuals for help on these functions.

Main Menu

The main menu bar appears when the main window of AIROBS is activated. It consists of
the menu options shown above. Each menu is discussed below.

File Menu
This menu is used to manage the map file options within AIROBS. When the user selects
File from the Main Menu Bar, the options shown below are provided. These options are
discussed below.
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Open Map
This menu option shows the Open Map dialog box, which allows the user to open a
previously created map file (*.mxd). Refer to ArcGIS documentation for more information.

Print Map
This menu option shows the Print dialog box, which allows the user to print the screen
currently in view in the main AIROBS ArcMap window.  Refer to ArcGIS documentation for
more information.

Export Map
This menu option shows the Export File dialog box. This option allows the user to export
the screen currently in view in the main AIROBS ArcMap window as a jpeg (*.jpg) image
file. Refer to ArcGIS documentation for more information.

Exit
This menu option closes the AIROBS program.

Data Layers Menu
This menu is used to manage the data layers within each map in AIROBS. When the user
selects Data Layers from the Main Menu Bar, the options shown below are provided. These
options are discussed below.

 

Add Data
This menu options activates the Select Data dialog box. It allows the users to add a data
layer to the current map. The data can come from any feature dataset and feature class files.
Refer to ArcGIS documentation for more information.

Configure Layers
This menu option activates the Layer Control dialog box. From this option the user can
make the layers visible, selectable, and add labels to each layer. In addition, the layer levels
can be rearranged as desired. The features of the Layer Control dialog box are comparable
to those of the Legend dialog box accessed through the Legend menu option or the View
Legend Button. The Layer Control dialog box is discussed below.
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Table of Contents
Opens the Table of Contents dialog box.  The user can arrange the order of the layers, turn
layers on and off, removing layers from the map, zooming to the layer, setting the visible
range, adjusting layer properties, adding labels to the features, and allowing the layer
features to be selectable. The features of the Table of Contents dialog box are comparable to
those of the Layer Control dialog box accessed through the Configure Layers menu option
or the Configure Layers Button. The Table of Contents dialog box is discussed below.

Legend
This menu option opens the Legend for airfield waiver data as displayed on the screen.

Temporary Waiver
These are for obstructions that are correctable.  These are not the same as the current
definition of a Temporary Waiver that relates to a waiver that is needed for the construction
or installation of a temporary facility.  A Temporary Waiver, as defined, is the only waiver
that requires the MAJCOM Vice Commander approval.  In addition, a Temporary Waiver is
the only status of waiver that needs to be reported to the MAJCOM on the Form 583.

Permanent Waiver
These are for all obstructions that can not be reasonably corrected and pose little or no threat
to flying operations.  Permanent waivers do not require an annual submittal; i.e. they are
not included on the Form 583, and rather are reviewed bi-annually during the Air Traffic
System Evaluation Program (ATSEP) inspection process.

Permissible Deviation
These obstructions are determined by evaluation of the obstruction in comparison to UFC 3-
260-1, Attachment 14, “Deviations from Criteria for Air Force Airfield Support Facilities”.
Obstructions that meet the criteria for Permissible Deviations do not require MAJCOM
review, but are subject to the bi-annual ATSEP inspection process.

Exemption
Obstructions classified as Exemptions are for facilities that were sited correctly under
previous criteria, but violate existing criteria.  For instance, if a hangar was previously sited
at 75’ setback from the parking apron based on the criteria of the time, it may now be a
violation because the setback requirements have expanded to 125’.  These obstructions do
not require reporting to the MAJCOM, but are subject to ATSEP review similar to a
Permissible Deviation and Permanent Waiver.  The installation date of these obstructions is
important to record as it is required that on the expiration of the useful life of that facility,
that the facility be sited correctly.

Unapproved
Obstructions in this category have not been classified or awaiting approval from MAJCOM
for classification as Temporary Waivers.
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View Menu
This menu is used to manage the display view of the current map file open in AIROBS.
When the user selects View from the Main Menu Bar, the options shown below are
provided. These options are discussed below.

Zoom In
This menu option activates the Zoom In cursor option tool. When the user clicks on this
menu option the cursor becomes activated as the tool to enlarge the current view. To zoom
in the user clicks and holds the mouse button to drag a box around the portion of the map
for which the enlargement is desired. The cursor will remain activated as the Zoom In
cursor option tool until another cursor option is selected.

Zoom Out
This menu option activates the Zoom Out cursor option tool. When the user clicks on this
menu option the cursor becomes activated as the tool to zoom out from the current view. To
zoom out the user clicks and holds the mouse button to drag a box around a portion of the
map for which zooming out from is desired. The cursor will remain activated as the Zoom
Out cursor option tool until another cursor option is selected.  This function is can be
confusing to new ArcView users.  To zoom out minimally, hold the cursor and make a large
box.  To zoom to a larger extent, hold the cursor and make a small box.

Zoom to Selected Features
When objects have been selected in ArcMap or with the AIROBS query functions, this
function allows the user to zoom the view pane to the extent of the selected objects or
obstructions.  This function will not activate when a single obstruction is selected.

Zoom to Full Extent
This menu option causes the map currently in use to increase or decrease its view to include
all the features on the map.

Undo Previous Extent
This menu option allows the user to display the view previously shown before the last view
change. This option can be chosen to re-display the map view history from when the file
was opened to the present view.
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Redo Previous Extend
This menu option is allows the user to display the view previously shown before the Undo
Previous Extent option was chosen. This option becomes activated only after the Undo
Previous Extent option has been chosen and will become deactivated if the user makes any
changes to the view window by using the Zoom In, Zoom Out, Zoom to Full Extent, or Pan
tools.

Pan
This menu option activates the Pan cursor option tool. When the user clicks on this menu
option the cursor becomes activated as the tool to change the current display without
changing the magnification of the map, known as panning. To pan the view the user clicks
and holds the mouse button to drag the map until the desired display is shown. The cursor
will remain activated as the Pan tool until another cursor option is selected.

Obstructions
This menu option displays the obstruction data points associated with the map file currently
opened. When the user clicks on this option the data points associated with each obstruction
are shown on the map. A different type of symbol is used to represent each type of
obstruction. The obstructions will remain displayed until turned off or removed by the user,
see the Table of Contents option.  When editing obstruction records, for instance when
changing an obstruction’s classification, this function should be activated to refresh the
obstructions to display the correct symbology.

Refresh
This menu option will refresh the view in the main AIROBS window. When this option is
chosen the map window is redrawn to show the most current updates to the map file.

Query Menu

Select Features
This menu option activates the Select Features cursor option tool. When the user clicks on
this menu option the cursor becomes activated as a tool to select data points on the map file.
To select a point the user clicks on the point that is desired. To select more than one point
the user clicks and holds the mouse button while dragging a box around the data to be
selected. The cursor will remain activated as the Select Features cursor option tool until
another cursor option is selected.

Clear Selection
This menu option will deselect any points selected while using the Select Features cursor
option tool from the Query menu or the Select Features button located on the Button Bar.
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Identify
This menu option will activate the Identify cursor option tool. When the user clicks on this
menu option the cursor becomes activated as a tool to select and identify attributes of map
data. Clicking on the map will open the Identify Results dialog box where the user can view
the data attributes for the identified data feature. For more information see Identify Results
dialog box below.

Query
This menu option opens the Query Features dialog box. This tool allows the user to query
and select data by class, attribute, and spatial constraints. For more information see Query
Features dialog box discussed below.

Identify Existing Obstructions
This menu options activates the Identify Obstructions cursor option tool. When the user
clicks on this menu option the cursor becomes activated as a tool to view the obstruction
attributes for each obstruction data point. When the user clicks on an obstruction data point
on the map the Edit Obstruction dialog box appears. This allows the user to view and
modify obstruction information. See Edit Structure dialog box for more information.

Query Existing Obstructions
This menu option activates the Query Obstructions dialog box. This tool allows the user to
find multiple obstructions that meet user defined criteria or to find a single obstruction
identified by the user.  For more information see Query Obstructions dialog box below.

Tools Menu

Obstruction Analyses
This menu option activates the Obstruction Analyses dialog box. This tool can be used for
priority risk area, airspace surface, and clearance zone analyses using selected criteria for
existing structures or a new structure which is user defined. See Obstruction Analyses
dialog box below for more information.

Reports
This menu option opens the Reports dialog box. This dialog box allows the user to generate
582, 583, and Priority Area Reports. See Reports dialog box discussed below for more
information.
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Export Obstruction Data
This function allows for the export of obstruction data to tab delimited text files.  These can
be imported into Microsoft Excel and sorted for obstruction classification.  This is a
powerful tool for examining obstructions in a list format.

Measure
This menu option activates the Measure cursor option tool. The Measure tool allows the
user to measure a distance on the map by clicking at one end point of the distance to be
measured and holding the mouse button until the second end of the distance to be
measured is reached. The distance is displayed while the mouse button is held down, but
disappears when it is not held. The cursor will remain activated at the Measure Cursor
option tool until another cursor option is selected.

Start ArcView
This menu option opens the ArcView program installed on the user's computer.  This menu
option allows the users to make changes to the map file that can be updated in AIROBS.
This function is also used to create the E-tab maps as described in the appendices.

Shutdown ArcView
This menu option closes the ArcView window opened by using the Start ArcView menu
option described above. If necessary, the user may need to save the file in ArcView before
the program will close.

Administration Menu
This menu is used to manage the airbase/structures and program options for AIROBS.
When the user selects Administration Menu from the Main Menu Bar, the options shown
below are provided.  These functions are also replicated on the Home and Setup dialog
boxes described above.

Set Airbase Map
This button opens the Edit Airbase Info dialog box. The user can edit the airbase name and
select map files; TIN files, and shape files to be associated with the airbase by using this
dialog box.  Additional information on the Edit Airbase Info dialog box can be found below.

Set Airbase Criteria
This permits the user to add or edit the airspace criteria used in the analysis of the airfield
obstructions by means of the Set Criteria dialog box.
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Edit Existing Obstructions
This menu option opens the Obstructions dialog box.  From the Obstructions dialog box the
user can select an obstruction to edit or delete from the obstruction database. For more
information see Obstruction dialog box discussed below.

Set Database
This menu option activates the Setup dialog box that allows the use to set the file location
for the database and the default airbase. The default airbase is the airbase that will be
selected in the Select an Airbase drop down menu on the Quick Task List by default, as well
as the map file that will be loaded by AIROBS automatically when AIROBS is opened. For
more information see Setup dialog box discussed below.

Help Menu
This menu is used to direct the user to help sources for AIROBS. When the user selects Help
from the Main Menu Bar, the options shown below are provided.

User Manual
This menu option activates this document.

AIROBS Home
This menu option opens the AIROBS Opening Screen. For more information see Opening
Screen discussed above.

Reference Materials
This menu option activates the Select a Reference to View dialog box. This dialog box allows
the user to view selected files that can be attached as references to AIROBS. See Select a
Reference to View dialogue box below for more information.

About AIROBS
This menu option activates the About AIROBS dialog box. This menu option allows the user
to view information about the AIROBS software as well as to view the system information
for the user’s computer. For more information see About AIROBS dialog box discussed
below.
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Button Bar

The button bar appears when the main window of AIROBS is activated. It consists of the
button icons shown above.  The left buttons are ArcMap functions and the right buttons are
AIROBS-specific buttons. The buttons act as shortcuts to options found in the menus on the
Main Menu Bar. Each button is discussed below.  For the ArcMap functions, the user is
referred to the ArcView manuals for additional information and assistance.

ArcMap Functions
Open Map Document

This button shows the Open Map dialog that allows the user to open a previously
created map file (*.mxd). Refer to ArcGIS documentation for more information.

Export
This button shows the Export File dialog box. This option allows the user to export the
screen currently in view in the main AIROBS window as a jpeg (*.jpg) image file. Refer
to ArcGIS documentation for more information.

Print
This button shows the Print dialog box that allows the user to print the screen currently
in view in the main AIROBS window. Refer to ArcGIS documentation for more
information.

Add Data
This button activates the Select Data dialog box. It allows the user to add a data layer
for viewing in the current map. The data can come from any feature dataset and
feature class files. Refer to ArcGIS documentation for more information.  Adding data
layers in this manner will not save the data layer to the MXD file on exiting the
AIROBS application.  If a new layer is required to be resident permanently in the MXD
file, this should be done in ArcMap.

View Legend
This button activates the waiver legend that identifies the symbology for each type of
waiver, i.e. Temporary Waiver, Permanent Waiver, Permissible Deviation, Exemption,
and Unapproved Obstruction.

View Table of Contents
This button opens the Table of Contents dialog box. The user can arrange the order of
the map layers, turn layers on and off, remove layers form the map, zoom to a layer’s
extents, set the visible range, adjust the layer properties, add labels to features, an
allow the layer features to be selectable. The features of the Table of Contents dialog
box are comparable to those of the Layer Control dialog box accessed through the
Configure Layers menu option or through the Configure Layers button. For more

ArcMap Functions AIROBS Functions
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information see Table of Contents dialog box discussed below.

Configure Layers
This button activates the Layer Control dialog box. From this option the user can make
the layers visible, selectable, and add layers to each layer. In addition, the layer levels
can be rearranged as desired. The features of the Layer Control dialog box are
comparable to those of the Legend dialog box accessed though the Legend menu
options or the View Legend Button. The Layer Control dialog box is discussed below.

Zoom In
This button activates the Zoom In cursor option tool. When the user clicks on this
button the cursor becomes activated as the tool to enlarge the current view. To zoom in
the user clicks and holds the mouse button to drag a box around the portion of the map
for which the enlargement is desired. The cursor will remain activated ad the Zoom In
cursor option tool until another cursor option is selected.

Zoom Out
This button activates the Zoom Out cursor option tool. When the user clicks on this
menu option the cursor becomes activated as the tool to zoom out from the current
view. To zoom out the user clicks and holds the mouse button to drag a box around a
portion of the map for which zooming out is desired. The cursor will remain activated
as the Zoom Out cursor option tool until another cursor option is selected.

Pan by Grab
This button activates the Pan cursor option tool. When the user clicks this button the
cursor becomes activated as the tool to change the current display without changing
the current magnification of the map, known as panning. To pan the view the user
clicks and holds the mouse button to drag the map until the desired display is shown.
The cursor will remain activated as the pan tool until another cursor option tool is
selected.

Zoom Display to Full Data Extent
This button causes the map currently in use to increase or decrease its view to include
all the features on the map.

Refresh Screen
This button will refresh the view in the main AIROBS window. When this option is
chosen the map window is redrawn to show the most current updates to the map file.

Draw Previous Extent
This button allows the user to display the view previously shown before the last view
change. This option can be chosen to re-display the map view history form when the
file was opened to the present view.

Redo Previous Extent
This button allows the user to display the previously shown view before the Undo
Previous Extent menu option or the Draw Previous Extent button was chosen. This
option becomes activated only after the Undo Previous Extent menu option or the
Draw Previous Extent button is chosen and will become deactivated if the user makes
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any changes to the current view extents by using the Zoom In, Zoom Out, Zoom to Full
Extent, or Pan tools.

Select Features Button
This button activates the Select Features cursor option tool. When the user clicks on this
menu option the cursor becomes activated as a tool to select data points on the map
file. To select a point the user clicks on the point on the map that is desired. To select
more than one point the user can click and hold the mouse button while dragging a
box around the data that needs to be selected. The cursor will remain activated as the
Select Features cursor option tool until another cursor option is selected.

When using this function, computers with limited graphic memory may experience a
reduced refresh rate.  Opening aerial imagery places high demands on the graphic
memory when panning around the map and using this tool adds further demands on
the available memory.

Zoom to Selected Features
This button activates the Zoom to Selected Features.

Clear Selection Button
This button will deselect any points selected while using the Select Features cursor
option tool from the Query menu or the Select Features Button located on the button
bar.

Identify Nearest Feature Button
This menu option will activate the Identify cursor option tool. When the user clicks on
this button the cursor becomes activated as a tool to select and identify attributes of
map data. Clicking on the map will open the Identify Results dialog box where the user
can view data attributes for the identified data feature.

Query Dialog Button
This button opens the Query Features dialog box. This tool allows the user to query
and select data by class, attribute, and spatial constraints. For more information see
Query Features dialog box discussed below.

Measure Distance Button
This menu option activates the Measure cursor option tool. The Measure tool allows
the user to measure a distance on the map by clicking at one end point of the distance
to be measured and holding the mouse button until the second end of the distance to
be measured is reached. The distance is displayed while the mouse button is held
down, but disappears when it is not held. The cursor will remain activated at the
Measure Cursor option tool until another cursor option is selected.

AIROBS Functions
View/Refresh Obstructions Button

This button displays the obstruction data points associated with the map file currently
opened. When the user clicks on this option the data points associated with each
obstruction are shown on the map. A different type of symbol is used to represent each
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type of obstruction. The obstructions will remain displayed until turned off or removed
by the user, see the Legend menu option or the View Legend Button.

Set Database Button
This button activates the Setup dialog box that allows the user to set the file location for
the database and the default airbase. The default airbase is the airbase that will be
selected in the Select an Airbase drop down menu on the opening screen by default, as
well as the map file that will be loaded by AIROBS automatically when AIROBS is
opened. See Setup dialog box discussed below for more information.

Set Airbase Map Button
This button opens the Edit Airbase Info dialog box. The user can edit the airbase name
and select map files; TIN files, and shape files to be associated with the airbase by
using this dialog box.  Additional information on the Edit Airbase Info dialog box can
be found below.

Set Airbase Criteria Button
This button opens the Set Criteria dialog box. The user can add new airspace criteria or
edit existing criteria by links to the required data files. See Set Criteria dialog box
discussed below for more information.

Edit Existing Obstructions Button
This button opens the Obstructions dialog box. From this dialog box the user can select
an obstruction to edit or delete from the obstruction database. For more information
see Obstruction dialog box discussed below.

Query Existing Obstructions Button
This button activates the Query Obstructions dialog box. This tool allows the user to
find multiple obstructions that meet user defined criteria or to find a single obstruction
identified by the user. For more information see Query Obstructions dialog box below.

New Obstruction Analyses Button
This button activates the Obstruction Analyses dialog box. This tool can be used for
running priority risk areas, airspace surface, and clearance zone analyses using a
selected criteria for existing structures or a new structure which is user defined. See
Obstruction Analyses dialog box below for more information.

Reports (Form 582, Form 583, and Priority Areas) Button
This button opens the Reports dialog box. This dialog box allows the user to generate
582, 583, and Priority Area Reports. See Reports dialog box discussed below for more
information.

Export Obstruction Data Button
This button activates the Export Obstruction data dialog box. This function extracts the
geospatial information and obstruction identifier for all waivers and permissible
deviations reported on the USAFE Form 583. This data is extracted to a tab-delimited
file for importing into CAD platforms used to publish the E-1 maps. See Export
Obstruction Data dialog box discussed below for more information.
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Identify Nearest Obstruction Button
This button activates the Identify Obstructions cursor option tool. When the user clicks
on this button the cursor becomes activated as a tool to view the obstruction attributes
for obstruction data points.  When the user clicks on an obstruction data point on the
map the Edit Obstruction dialog box appears. This allows the user to view and modify
obstruction information. See Edit Obstruction dialog box discussed below for more
information.

User Manual Button
This button activates this document from within the AIROBS application.

Reference Materials Button
This button activates the Select a Reference to View dialogue box from which the user
can view the reference materials automatically from within the AIROBS application
using the native format of the reference material. See Select a Reference to View dialog
box discussed below for more information.

AIROBS Home Button
This menu option opens the Home dialog box. For more information see Opening
Screen discussed above.

Dialog Boxes
About AIROBS
This dialog box, shown to the right,
provides the user information about
the version of AIROBS that they are
running on their computer.

When the user clicks the Ok button
the About AIROBS dialog box closes.
When the user clicks the System Info
button the System Information dialog
box, shown below, is displayed.
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The System Information dialog box is
a Windows feature, and can usually
be accessed from the Start Menu >
Programs > Accessories > System
Tools > System Information.

For help using the System
Information dialog box features click
on the Help menu option under the
Action menu or the Help button ( )
located on the button bar, both
located in the System Information
dialog box.

Setup
This dialog box sets the location of the
database containing the obstruction data and
for storage of the analysis results.

Clicking the "Next" button above results in a
second dialog box for setting the airbase to
which the obstruction data is related.  The
airbase is selected from the drop down
menu.
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Edit Airbase Info
This dialog box is for setting the
location of the *.mxd file
containing the base mapping on
which the obstructions are to be
displayed, links to the ground TIN
file, connection to the priority risk
area shape file, and inclusion of
the runway centerline file.  This is
all the data that is required that is
not dependent of the selected
airspace criteria.

Set Criteria
This dialog box allows the user to
add new airspace criteria and edit
existing criteria by linking
alternate airspace surface TIN
files, airspace surface shape files,
and taxiway/apron clearance
shape files.

Warning:  Editing or replacing
criteria files will erase all
obstructions for the database
related to that criterion.  This
warning message will appear to
warn the user that this will occur.
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Edit Existing Obstructions
Listed in this dialog box are the
obstructions that have been analyzed
by AIROBS.  The obstructions are
listed by Obstruction Number and the
description of the obstruction as
stored in the database.  Selecting any
of the obstructions and clicking the
edit button brings up the Edit
Obstructions box shown below.
Clicking delete will remove the
obstruction from the database.
Clicking close will close the dialog
box.

When an obstruction is selected from
this list, the obstruction is highlighted
(selected) on the screen.  When an
obstruction is selected, users may find
the zoom functions to be sluggish.
This is caused by increased demands
on graphic memory.  Deselecting the
obstruction will remove this
condition.
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This dialog box is the primary user interface for managing the airfield obstructions.  Data
shown at opening the dialog box is populated from the Obstructions Database.  The left side
of this dialog base is the data related to the obstruction itself.  The left side of the dialog box
relates to the survey points that are included in the obstruction.  Obstructions may be
composed of several surveyed objects that are grouped into a single obstruction.

Basic Info
Data for this area comes both from the obstruction database and by user input.  The
principal purpose of this dialog area is to define the waivers and permissible deviations.

Obstruction Number
This field is to be populated by the user in accordance with MAJCOM requirements.  The
USAFE guidelines for obstruction numbering are provided in the Reference Materials.  A
unique number is required for each obstruction.

Obstruction Classification
This sets whether the selected obstruction is a Temporary or Permanent Obstruction,
Permissible Deviation, Exemption, or Unapproved Obstruction.

Permissible Deviation Help
 This box will activate the current criteria for determination of a Permissible

Deviation.  In this instance it will open Attachment 14 of UFC 3-260-1.
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Waiver Status
Allows for tracking and storage of Approved and Pending waivers.

Date
Posting for the date of waiver approval.

Waiver Reference
Allows for the insertion of base or MAJCOM reference information related to the waiver.

Installation Date
Specify the date of installation if known.

Construction Type
User can select if the obstruction is temporary, e.g. construction crane, or permanent in
nature.  This relates specifically to the construction type and not the waiver type.

Obstruction Description and Comments
The field is populated from the database, but can be modified by the user as needed to
describe the obstruction.

Violations
This is not a user input area, this provides the information in the database related to criteria
that the obstructions violate.

Priority Area
This lists the priority area where the object is located, PA1, PA2, or PA3.  This is not a user-
input box.

Obstruction Frangible
This allows the user to input the frangibility of the obstruction.  For obstructions that are
grouped, if all objects are frangible, the obstruction is frangible and likewise if all objects are
non-frangible.  For obstructions that have a mixture of frangible and non-frangible objects,
e.g. aircraft arrestor systems, the obstruction must be listed as non-frangible.

Corrective Action Information
These are user-input fields related to the cost and priority of removal of the obstructions.

Project/Work Order Number
This field allows for the recording of the project or work order number under which the
obstruction will be corrected or removed.

Estimated/Programmed Cost
User entered field for the cost of correction or removal for the given obstruction for
management of obstruction removal programs.

FIM Rating
Allows user entry of the FIM Rating for the given obstruction.  The possible selections are
Degraded, Critical, and Enhancement.

ORM Ranking
Specify the Operational Risk Management risk level as Extreme, High, Medium, or Low.

Estimated Removal Date
Insert the Fiscal Year when the obstruction correction or removal will be executed.
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Survey Information
This dialog area lists the name and the coordinates of the survey points that compose the
selected obstruction.  Scrolling  to other survey points in this box will alter the
information below.  Data for populating this area comes from a combination of the
obstruction database and user inputs.  All fields relate to the survey point selected in the
Survey Points in dialog area.  The Survey Date field is entered as month/date/year
(mm/dd/yyyy).  To save changes made to this area, hit the apply button before exiting the
dialog box.

Distance Measurements
This box is completed from the analysis of the obstruction from values stored in the
database.  The user can not edit the box.

Images
The obstruction database provided at installation may include digital images of the
obstructions.  If there is an image of the obstruction, its image will be shown.  However,
users may add images as well for each survey point.  Selecting the Add or Edit buttons
results in the dialog box shown below.
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Query Obstructions
This dialog box allows the user
to query the AIROBS database
based on selected criteria.  The
results of the query are
displayed in the bottom area.
Queries of a single obstruction
will provide the violations of
that obstruction in the results
area.

Note that Permissible
Deviations only apply for the
governing criteria for the
determination and granting of
waivers, that is the USAFE
criteria. For all other criteria,
this field is not selectable
because Permissible Deviations
do not apply to these criteria.
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New Obstruction Analyses
This dialog box provides for
analyses of either single
obstructions or obstructions that
are loaded in the database.  For a
single obstruction analysis, the user
may enter the coordinates or select
the X Coord, Y Coord, and Ground
Elevation (if available) by clicking
on the ArcMap screen.  An
identifier will be shown on the
screen when the Ground TIN file is
available only.  Users must select
an airspace criterion and the
required analyses before selecting
the Analyze button to run the
analysis.

Reports
This dialog box is for the creation
of the specific USAFE reports and
allows the user to specify the
location of the resulting report.
The Next button results in the
second Reports dialog box shown
below allowing the user to specify
which obstructions to report.  The
default file location is to the “My
Documents” folder, but this can be
changed by browsing to the desired
location by hitting this button: .
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For the Form 583, the only option
available to users is to select all
structures.  For the other reports,
the user may select from the
available structures.

E-Tab Creation
The creation of E-Tab mapping is provided in the ArcView environment.  The workflow for
creating the E-Tab maps is provided in the Frequently Asked Questions section.

Select a Reference to View
Reference material listed as
previously loaded at installation or
added subsequently by the user.
See file locations for assistance on
adding new reference materials.

Export Obstruction Data
This function extracts the geospatial
information and obstruction identifiers for all
waivers and permissible deviations reported on
the USAFE Form 583 into a tab-delimited file
with the headings Obstruction ID, X
Coordinate, Y Coordinate, Ground Elevation,
and Obstruction Classification.  This file can be
used to import this data into other applications
such as AutoCAD.
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Layer Control
This feature allows the user to
change the level a layer is on,
make data on a given level
Visible/Invisible,
Selectable/Non-Selectable, and
add/remove Labels. The
symbology of all data features
in a layer can be modified here.
Right clicking on any of the
layers will bring up the
following options: Remove
Layer, Visible, Selectable, Label,
and Properties. Remove Layer
will remove the layer form the
map file. Visible will make the
layer visible/invisible.
Selectable will make the data
selectable or non-selectable.
Label will add or remove labels
from each data point. Properties
will bring up the ArcGIS
properties dialog box. For more
information on the Properties
dialog box, refer to ArcGIS
documentation.
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Table of Contents
This dialog box allows the user to adjust layer properties
within the current map file. Checking/un-checking the box
next to each layer will toggle the layer on/off. Right clicking
on a layer will bring up the following options:

Remove
This option will remove the selected layer from the map file.

Zoom to Layer
This option will update the scale to include all data included
on the selected layer.

Visible Scale Range
This option allows the user to set the minimum scale range,
maximum scale range, and clear the scale range.

Selectable
This option allows the user to make features on a layer
selectable/non-selectable in AIROBS.

Label Features
This option adds a label to each feature in the selected layer.

Properties
This feature opens the ArcGIS data layer properties box. See
ArcGIS documentation for more information.

Query Features
The query features dialog box
allows the user to select map
features using various criteria.

Class
The Class tab allows the data to be
selected based on the layer it is
associated with. All data on this
layer will be selected. Select a
layer and click the Apply button to
select data. Click the Discard
button to deselect the data. Click
the Cancel button to close the
dialog box.
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Attribute
The Attribute tab allows the user
to select data based on the layer it
is associated with and the attribute
constraints that the user places on
it. After selecting the data layer,
the Attributes box shown at right,
populates with available attribute
data. The user then selects the
desired attribute data and sets
constraints for data selection in the
Attribute Value boxes shown at
right. Clicking apply will select the
data that meets the specified
criteria.

Spatial Constraint
This option allows the user to
select data based on the layer it is
associated with and the spatial
constraints that are assigned by
the user. After selecting a layer the
user must choose a Spatial Extent
as shown at right. After clicking a
button in the spatial extent box,
the dialog box will close so that a
spatial area can be selected. After
selecting the dialog box will re-
appear.  Clicking apply will select
the data that meets the specified
criteria.
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AIROBS Messages

Listed below are messages included in the AIROBS code.  This listing does not provide the
possible error messages from third-party software associated with AIROBS such as ArcGIS,
Adobe Reader, print drivers, and Windows operating system.  Please refer to the help
functions in that software for messages not listed here.

AIROBS MESSAGES
Message Description Module

The database is password protected. Go to the
Setup->Set Database dialog and set the correct
password to the database.

Displayed when access to a password
protected database failed.

Startup

The AIROBS application cannot be run on this
computer. You either do not have ArcMap
installed on this computer or do not have the
ArcView license. Click OK to exit.

Displayed when the necessary
ArcMap/ArcView components are not
installed on the computer.

Startup

The database has not yet been set up. Do you
want to set it up now?

Displayed when the database is not yet
set up.

Startup

The database has not yet been set up. Please
click 'Set Up' and then 'Set Database' to set up the
database.

Displayed when the database is not yet
set up.

Startup

Please select a reference document from the list. Displayed when there is no reference
document selected.

Reference
Materials

Please select a data file. Displayed when there is no data input file
specified.

Data Input

Please specify a file name and path to export the
results to.

Displayed when path to save the report
is not specified.

Reports

The network name \\babel\reports could not be
found.

Displayed when the specified network
directory cannot be accessed.

Reports

The folder d:\reports isn't accessible. Displayed when the directory specified
cannot be accessed.

Reports

There is no data for the selected report. Displayed when there are no data from
the database for the selected report

Reports

Report created successfully. Displayed when the report is successfully
created.

Reports

Editing the criterion setup information will cause
the obstruction analysis results for the criterion to
be deleted. You will need to run the analysis for
this criterion again to view the obstructions if you
proceed. Do you really want to proceed and delete
the analysis results?

Confirm the deletion of the analysis
results when setting up the criteria
information.

Set Criteria

Do you want to delete the selected criterion from
the airbase? All data related to criterion for the
airbase will be deleted and the result cannot be
reversed.

Confirm the deletion of the selected
criterion.

Set Criteria

One or more entries are not valid. Please verify
and try again.

Displayed when the path or password to
the database is not valid.

Set Database



63

AIROBS MESSAGES
Message Description Module

An error has occurred while saving the setup
information. Information is not saved.

Displayed when an error has been
encountered when saving the setup
information.

Set Database

Setup information has been successfully saved. Displayed when the setup information is
successfully saved.

Set Database

Are you sure you want to delete the obstruction
from the database?

Confirm the deletion of an obstruction. Edit
Obstruction

The image file is not specified. Displayed when no image file is
specified.

Edit
Obstruction

The image date is invalid. Displayed when the image specified is
invalid.

Edit
Obstruction

A structure with the same structure name already
exists in the database.

Displayed when a duplicated structure
name is already in the database when
saving a new structure.

Edit
Obstruction

Please enter a number for the obstruction. Displayed when the obstruction is
missing.

Edit
Obstruction

Please select a classification. Displayed when the obstruction
classification is missing.

Edit
Obstruction

The install date is invalid. Displayed when the date is invalid. Edit
Obstruction

The estimated removal date is invalid. Displayed when the date is invalid. Edit
Obstruction

The remove cost is not a valid number. Displayed when the input is invalid. Edit
Obstruction

Please enter a date for the waiver application or
approval date.

Displayed when the waiver date is
missing.

Edit
Obstruction

The waiver status date is invalid. Displayed when the waiver date is
invalid.

Edit
Obstruction

The remove by date is invalid. Displayed when the date is invalid. Edit
Obstruction

X coordinate is required. Displayed when the X coordinate is
missing.

Edit
Obstruction

The X coordinate is not a valid number. Displayed when the X coordinate is
invalid.

Edit
Obstruction

Y coordinate is required. Displayed when the Y coordinate is
missing.

Edit
Obstruction

The Y coordinate is not a valid number. Displayed when the Y coordinate is
invalid.

Edit
Obstruction

Height is required. Displayed when the height is missing. Edit
Obstruction

The height is not a valid number. Displayed when the height is invalid. Edit
Obstruction

The ground elevation is not a valid number. Displayed when the input is invalid. Edit
Obstruction

The top elevation is not a valid number. Displayed when the input is invalid. Edit
Obstruction



64

AIROBS MESSAGES
Message Description Module

The survey date is invalid. Displayed when the input is invalid. Edit
Obstruction

Please select frangibility. Displayed when frangibility is missing. Edit
Obstruction

Data has been successfully saved to the
database.

Displayed when the analysis results have
been successfully saved to the database.

Analyses

The analysis results have not been saved to the
database. Do you really want to close the dialog
without saving the analysis results?

Displayed when the user is trying to
close the analysis dialog without saving
the analysis results.

Analyses

Please select one or more analyses. Displayed when there is analysis is
checked.

Analyses

Please enter the X coordinate of the structure. Displayed when the X coordinate is
missing.

Analyses

Please enter the Y coordinate of the structure. Displayed when the Y coordinate is
missing.

Analyses

Please enter the height of the structure. Displayed when the height is missing. Analyses

The X coordinate you entered contains an invalid
number.

Displayed when the input is invalid. Analyses

The Y coordinate you entered contains an invalid
number.

Displayed when the input is invalid. Analyses

The height you entered contains an invalid
number.

Displayed when the input is invalid. Analyses

The base elevation you entered contains an
invalid number.

Displayed when the input is invalid. Analyses

There are no structures in the database for the
airbase.

Displayed when there are no structures
in the database to be analyzed.

Analyses

The priority risk area shape file has not been set
up for the airbase. Please go to Administration-
>Set Airbase Map to set up the shape file.

Displayed when the priority risk area
shape file has not be set up.

Analyses

The airspace surface TIN file has not been set up
for the airbase and selected criterion. Please go to
Administration->Set Airbase Criteria to set up the
TIN file.

Displayed when the airspace TIN file has
not be set up.

Analyses

The airspace surface shape file has not been set
up for the airbase and selected criterion. Please
go to Administration->Set Airbase Criteria to set
up the shape file.

Displayed when the airspace shape file
has not be set up.

Analyses

The clearance zone shape file has not been set
up for the airbase and the selected criterion.
Please go to Administration->Set Airbase Criteria
to set up the shape file.

Displayed when the clearance zone
shape file has not be set up.

Analyses

There are no obstructions in the database for the
selected criterion. No layer was created.

Displayed when there are no
obstructions in the database.

View
Obstructions
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Known Application Bugs

E-Tab Symbology
When opening ArcView for preparation of an E Tab, the icon symbology for the various
obstruction types is not immediately passed to ArcView.  To get the right icons, the
“Properties” sheet for the Obstruction Layer must be opened by right clicking on
Obstructions and selecting Properties.  Next, select the “Symbology” tab and press “OK.”
The correct icons will now appear.  The development team is working with ESRI to correct
this bug.

Memory Usage
The application can return error messages such as “Error Call Stack Sequence” with “Divide
by Zero” when the program is heavily tasked while running other applications or when
zooming in and out with multiple layers.  This error is more likely to occur with less
powerful computers (limited video memory, limited hard drive space, etc.)  When this error
message is displayed, the application will almost always recover when the “Set Airbase
Map” button is pushed.  When the set map dialogue opens, press “OK.”  This error does not
affect data or the database.


